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CHAPTER 1

Introduction
Supported In:

You can include an index in your output through the use of index keywords. An Index proxy is also
necessary for print-based outputs. Unlike some features in Flare Desktop, there is no independent
index file in your project that becomes the index in your output. Instead, the index is automatically
generated when you build output, based on index keywords that you insert into content files in your
project.
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EXAMPLE—ONLINE OUTPUT

EXAMPLE—PRINT OUTPUT

CHAPTER 1  6



Methods

n Method 1 "Adding Index Keywords" on page 10 and "Assigning Topics to Index Keywords" on
page 13

n Method 2 "Inserting Index Keywords" on page 16

n Method 3 "Creating Auto-Indexes" on page 21

General Information

n "Benefits of the Flare Method of Indexing" on page 26

n "Online vs. Print Index" on page 27

n "When to Add Index Keywords" on page 28

n "Keywords and Subkeywords" on page 29

n "Index Features Per Output Type" on page 31

Main Activities

n "Creating Index Links" on page 34

n "Enabling Indexes in Skins" on page 50 (HTML5 Tripane and Standard Skins)

n "Creating an Index Manually for Print" on page 52

n "Editing the Look of a Print Index" on page 55

Other Activities

n "Auto-Generating Indexes for Print" on page 65

n "Creating a Binary Index" on page 79

n "Creating Multiline Indentation" on page 80

n "Deleting Index Keywords" on page 82

n "Editing Index Keywords" on page 83

n "Editing Index Links" on page 85

n "Excluding Index Entries From Search" on page 89

n "Including Bookmarks in Index Entries" on page 90

n "Including or Excluding Index Headings" on page 96
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NOTE For online outputs, creating an index is typically done via a skin. By default, the
MadCap style that controls index proxies is set to support only print-based outputs.
However, you can change this. To do so, open your stylesheet, select the
MadCap|indexProxy style, and set the mc-output-support property to all (all-print is the
default setting). By doing this, you can use the index proxy method to generate an index in
some online outputs as well.

CHAPTER 1  8



CHAPTER 2

Methods for Creating Indexes
Following are the different methods available for creating indexes:

n Method 1 "Adding Index Keywords" on the next page and "Assigning Topics to Index
Keywords" on page 13

n Method 2 "Inserting Index Keywords" on page 16

n Method 3 "Creating Auto-Indexes" on page 21
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Adding Index Keywords
The following steps show how to add keywords to your index library so that you can use them later.
But doing this does not automatically insert the new keywords into content files. For steps on doing
that, see "Inserting Index Keywords" on page 16.

How to Add an Index Keyword or Subkeyword
1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Index Window.

n Keyboard Shortcut Press F9.

The Index window pane opens. The window pane is split into two sections—the Terms area at
the top and the Explorer area at the bottom. If you want to see more or less of either section,
you can click the splitter between them and drag it up or down.

2. Do one of the following, depending on whether you are adding a first-level keyword or a
second-level index keyword:

n First-Level Keyword Right-click the explorer area at the bottom of the window pane, and
select Add Top-Level Keyword from the context menu.

OR

n Second-Level Subkeyword In the explorer area at the bottom of the window pane, right-
click an existing top-level keyword. From the context menu select Add Sub-Keyword.

NOTE If you want to add a keyword that begins with a colon, you need to type a
backwards slash \ first, followed by the colon and then the term (e.g., \:My keyword).
If you want to add a subkeyword that starts with a colon, you can do the same,
although you still need to include the original colon that indicates it is a subkeyword
(e.g., My keyword:\:mysubkeyword).

3. Type the index keyword as you want it to appear in the index.

4. Press ENTER.
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EXAMPLE You want to add the index keyword "Salad" to some topics in your project. One
way to accomplish this is to open those topics and insert the index keyword into them.
Another way is to open the Index window pane, right-click anywhere in the explorer area at
the bottom of the window pane, and select Add Top-Level Keyword.
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Now let's say that you want to create a subkeyword called "Cobb" under the top-level
keyword "Salad." First, you right-click on Salad and select Add Sub-Keyword.

NOTE If you use "Sort As" links in your index, they will apply to both first- and second-level
index keywords. See "Creating Index Links" on page 34.
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Assigning Topics to Index Keywords
After you add index keywords or subkeywords in the Index window pane, you can assign topics to
them.

How to Assign Topics to Keywords Using the
Index Window Pane

1. Select View > Index Window or press F9.

The Index window pane opens. The window pane is split into two sections—the Terms area at
the top and the Explorer area at the bottom. If you want to see more or less of either section,
you can click the splitter between them and drag it up or down.

2. Right-click on the keyword or subkeyword and from the context menu select Assign Topic.
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3. In the dialog that opens, find and select the topic(s).

If you want to select multiple topics, first click in the local toolbar. Then double-click the
folder holding the files. You can hold the SHIFT key to select a range, or you can hold the
CTRL key to select individual items.

4. In the dialog, click Open. Paths to the selected topics are displayed in the Index window pane
after the keyword. And an index marker is added at the beginning of each topic.
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How to Assign Topics to Keywords Using the
Content Explorer

1. Open the Content Explorer.

2. Select View > Index Window or press F9 on your keyboard.

3. In the local toolbar of the Content Explorer, click the Show Files button . The window
pane splits into left and right halves.

4. In the left half of the Content Explorer, click the folder holding the topics that you want to
assign to an index keyword.

5. In the right half of the Content Explorer, select the topics. You can hold the SHIFT key to
select a range, or you can hold the CTRL key to select individual items.

6. Drag the selected topics and drop them on the index keyword or subkeyword that is displayed
the bottom (explorer) portion of the Index window pane.
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Inserting Index Keywords
There are a few different ways to insert an index keyword into a topic or snippet, and each has its
own advantages.

Does it matter where you insert an index keyword in a topic? Typically, you want to insert the index
keyword at the location closest to where the subject is discussed. One reason for this is to keep
index keywords accurate in print-based output. Let’s say you have a very long topic that discusses
many subjects and you have inserted all of the index keywords at the top of the topic. In print-based
output it is likely that the topic will be spread out to multiple pages. With the index keywords
inserted at the top of the topic, the final index will point to the first printed page containing that
topic, rather than the exact page where the subject is discussed. However, it is also helpful to insert
keywords to your headings in a topic. This helps improve search results.

Drag-and-Drop Method
Use this method to quickly insert an index keyword that already exists in your project.

n Advantage It is extremely fast.

n Disadvantage The index keyword that you want to insert must already exist in the project.
This means you must first insert the index keyword into a topic using one of the other
methods.

How to Insert a Keyword Using the Drag-and-Drop
Method

1. Open the content file.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Index Window.

n Keyboard Shortcut Press F9.

3. In the bottom (explorer) area of the Index window pane, click the index keyword and drag it to
the location in the topic or snippet where you want to insert it. As you drag the keyword into
the topic or snippet, a vertical red bar acts as a guide to help you place the keyword.
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4. The index keyword is displayed within a marker in front of the word where you added it (as
long as markers are turned on).

5. Click to save your work.

Quick Term Method
Use this method to quickly insert the first word located after your cursor as an index keyword.

n Advantage It is extremely fast.

n Disadvantage It is not the method to use if you want to customize your phrase, use a variable,
or add a second-level keyword. The word located immediately after the cursor is exactly what
will be displayed in the index.

How to Insert a Keyword Using the Quick Term Method
1. Open the content file.

2. Click before or on the word that you want to insert as an index keyword.

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Insert > Keyword.

n Keyboard Shortcut Press F10 on your keyboard.

The index keyword is displayed within a marker in front of the word where you added it (as
long as markers are turned on).

4. Click to save your work.
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Index Window Pane Method
Use this method to enter a keyword in the Index window pane.

n Advantage It lets you customize the wording of the phrase in the index, or even use a variable.
It also lets you add a second-level index keyword.

n Disadvantage It is not quite as fast as the other methods.

How to Insert a Keyword Using the Index Window Pane
Method

1. Open the content file.

2. Click at the location in the topic or snippet where want to insert an index keyword.

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Index Window.

n Keyboard Shortcut Press F9 on your keyboard.

The Index window pane opens.

The window pane is split into two sections—the Terms area at the top and the Explorer area
at the bottom. If you want to see more or less of either section, you can click the splitter
between them and drag it up or down.

4. Click in an empty field in the Terms column.

5. Type the index keyword as you want it to appear in the index.

If you want to add a second level to the keyword, type a colon after the first term, and then
type the second term.

EXAMPLE If you type Software:MadCap Flare, the term "Software" appears at
the first level of the index, and the term "MadCap Flare" appears as a subentry under
"Software."
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If you want to insert a variable, you can click in the Index window pane and use the dialog
to choose a variable. The variable will appear as syntax in the field, but in the output the
variable definition will be shown.

NOTE If you want to add a keyword that begins with a colon, you need to type a
backwards slash \ first, followed by the colon and then the term (e.g., \:My keyword).
If you want to add a subkeyword that starts with a colon, you can do the same,
although you still need to include the original colon that indicates it is a subkeyword
(e.g., My keyword:\:mysubkeyword).

6. Press ENTER.

The index keyword is displayed within a marker in front of the word where you added it (as
long as markers are turned on).

7. Click to save your work.

Index Entry Mode Method
Use this method to accomplish the same thing as the Index window pane method. The difference is
that, with this method, you do not need to move your cursor from the topic or snippet to the Index
window pane. You simply click at the spot in the text where you want to insert the keyword and
start typing. The words you type are added directly into the Index window pane. This is a good
method to use if you plan to do a lot of indexing all at once, without performing any other tasks in
the topic or snippet.

n Advantage It is extremely fast and lets you customize phrasing and add second-level
keywords.

n Disadvantage It is not the best method to use if you want to perform indexing while also
adding other content and formatting to topics or snippets.
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How to Insert a Keyword Using the Index Entry Mode
Method

1. Open the content file.

2. In the local toolbar of the XML Editor click . The cursor changes, displaying a small boxed
"i" next to it.

3. Click at the place in your topic where you want to add an index keyword.

4. Type the phrase that you want to add as the index keyword.

As you start typing, the Index window pane opens (if it was not previously opened), and the
phrase is added to the first empty field under the Terms column.

If you want to add a second level to the keyword, type a colon after the first term, and then
type the second term.

If you want to insert a variable, you can click in the Index window pane and use the dialog
to choose a variable. The variable will appear as syntax in the field, but in the output the
variable definition will be shown.

5. Press ENTER. The index keyword is displayed within a marker in front of the word where you
added it (as long as markers are turned on).

6. If you want to add more index keywords in the topic, repeat Steps 3-5.

7. Click to save your work.

NOTE If you want to turn off the index entry mode and return to regular editing, click
again.
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Creating Auto-Indexes
An auto-index lets you automatically add words in your project to a generated index, rather than
inserting all of the index markers manually. To do this, you can add phrases and corresponding
index entries to an auto-index file. When you generate the output, Flare Desktop scans the auto-
index file and adds the words it finds to the generated index.

EXAMPLE You want to make sure that the word "Pasta" appears in your generated index,
containing links to all of the topics where that word is found. Your first option is to
manually insert the "Pasta" index marker into all of those topics. Your second option is to
add the word "Pasta" to an auto-index file. When you generate the output, Flare Desktop
automatically creates index entries and links for the words and phrases in your auto-index
file, including the word "Pasta."
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How to Create an Auto-Index
1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Advanced > Auto-index Phrase Set.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Auto-index Phrase Set.

The Add File dialog opens.

2. In the File Type field at the top, make sure Auto-index Phrase Set is selected.

3. In the Source area, choose to create the new file based on a template or an existing file.

n New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare Desktop,
expand the Factory Templates folder and click on a template file. If you want to use
your own custom template file, expand the appropriate folder and click on a file. For
more information about templates, see the Help system.

n New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click , use the Open File dialog to find a file, and
double-click it.

4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click and select the subfolder. Otherwise,
keep the default location.

5. In the File Name field, provide a name for the auto-index phrase set file.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The Auto-index Editor opens. Also, the auto-index file (.flaix extension) is added to
the Advanced folder in the Project Organizer. In the future, you can open the auto-index
phrase set from there.
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9. For each phrase in your project that you want to be automatically converted to a particular
index entry, complete the following steps in the Auto-index Editor:

a. In the local toolbar, click . The Auto-Index dialog opens and a new row is added to the
editor.

b. In the Phrase field, type the word(s) that you want Flare Desktop to find in your project
and use as the basis for a new index entry. Please note that the fields in this dialog are
case-sensitive; therefore, if you enter a phrase with the initial word capitalized, only
occurrences just like that in your topics will be used to create index entries. If you want
to insert a variable in a field, you can click . The variable will appear as syntax in the
field, but in the output the variable definition will be shown.

NOTE If you want to see the variable syntax replaced by the variable definition,
click in the local toolbar of the editor. This shows you the "Evaluated
Phrase," which determines the actual text of the variable.

c. If you want the auto-index to add markers to words regardless of if they are upper or
lower case, select Ignore case.

d. In the Index Term field, enter the word(s) to be added to the generated index. To create
a multi-level index entry, separate the first-level term and the second-level term with a
colon. Again, you can insert a variable by clicking .

EXAMPLE You entered pasta in the Phrase field and Pasta in the Index Term
field. In that case, the generated index in the print-based output will display like
this:
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The index entry points to any topics where the lowercase instance of "pasta"
has been found. If you also want the index entry to point to occurrences where
the word is not all lowercase ("Pasta"), add another row to the Auto-Index
Editor and create a phrase for it (i.e., enter Pasta in both the Phrase field and
the Index Term field).

Let's say that your project talks about many kinds of pasta and you want to
create multiple index entries for certain words, some with single-level entries
and others with sublevels. Maybe you want Flare Desktop to scan the project
for "rigatoni." When it finds occurrences, you might want a single-level index
entry like this:

In that case, you would enter rigatoni in the Phrase field and Rigatoni in
the Index Term field. That index entry would point to all of instances of
"rigatoni" in the project. But you also might want a multi-level index entry
displayed like this:

In that case, you would enter rigatoni in the Phrase field and
Pasta:rigatoni in the Index Term field.

e. Click OK.

10. Click to save your work.

NOTE For print-based outputs, you can also use an option to auto-generate indexes for the
output. See "Auto-Generating Indexes for Print" on page 65.
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CHAPTER 3

General Information for Indexes
There are various pieces of general information you should know if you plan to use this feature.

This chapter discusses the following:

Benefits of the Flare Method of Indexing 26

Online vs. Print Index 27

When to Add Index Keywords 28

Keywords and Subkeywords 29

Index Features Per Output Type 31
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Benefits of the Flare Method of
Indexing

Flare Desktop's method of producing an index includes the following benefits:

n Prevents Index Keywords from Pointing to Deleted Content Let's say you have inserted an
index keyword within a particular paragraph in a topic. Later, you decide to delete the
paragraph. Doing this also deletes the index keyword, so when the index is generated, that
index keyword is no longer included in it. You do not have to remember to delete the index
keyword from another location or file.

n Copies Index Keywords for You Let's say you have inserted an index keyword within a
particular paragraph in a topic. You then copy that paragraph and paste it into another topic.
When you do this, the index keyword is also copied, which means that you do not have to
worry about creating it again for that topic.
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Online vs. Print Index
An index in Flare Desktop works much like an index in a printed book. It provides key terms that
point the user or reader to specific locations where the information is stored. The main difference is
that, in a printed book, a reader must manually turn pages to get to the desired page listed in the
index. In online output, an end user simply clicks an item in the index and the item opens
immediately.

When you create print output, you can convert your online index to printed format.
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When to Add Index Keywords
There is no right or wrong answer to this. As you gain experience, you will develop your own work
habits that fit you best. Some authors add index keywords as they work on each topic. Other
authors wait until they are near the end of the development process and add index keywords all at
once. Here are a few benefits of waiting until the later in the process to add index keywords:

n If you add index keywords as you create and work on each topic, it's possible that you will
forget to add index keywords if you later make changes to a topic. If you wait until the later in
the process to add index keywords all at once, you are less likely to miss sections in topics.

n You might find that your wording is more consistent if you wait to add all your index keywords
at the same time. Projects can take months to develop, and over time it is easy to stray from
using consistent terms.

EXAMPLE Early in the development process, you might start using the word "modify"
in several index keywords, but later on you might forget and start using the word
"change" instead. In the end, some topics would be connected to index keywords
using the word "modify," while other topics would be connect to keywords using the
word "change."

n For authors who add index keywords all at once, Flare Desktop provides two features that
can be quite useful ("Index Entry Mode" and "saved layouts").
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Keywords and Subkeywords
Keywords and subkeywords are the primary building blocks for an index. They are displayed in
topics (as you edit them) as markers; each marker can hold multiple keywords.

Keywords are simply terms at the first level in an index. You might have a term that can be broken
down even further. In that case, you might decide to also create subkeywords, which are at the
second-level in an index.

When you generate the output the index is automatically created based on these keywords and
subkeywords. The keywords and subkeywords are visible to the end user in the generated index,
but not in the individual topics.
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NOTE If you are using "Sort As" index links (see "Creating Index Links" on page 34), they will
apply to both keywords and subkeywords.

CHAPTER 3  30



Index Features Per Output Type
Following are index features supported in each output type.

HTML5 PDF Word
Clean
XHTML

Eclipse
Help EPUB

HTML
Help PPTX

Indexes
Supported
(via
Proxy)1

Indexes
Supported
(via Skin)

Auto-
Generate

Binary
Indexes

Bookmarks
in Index
Entries

Index Links

Search
(Can
Exclude
Index
Entries
From
Search)
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HTML5 PDF Word
Clean
XHTML

Eclipse
Help EPUB

HTML
Help PPTX

Sorting
(Index
Links)

1For online outputs, creating an index is typically done via a skin. By default, the
MadCap style that controls index proxies is set to support only print-based
outputs. However, you can change this. To do so, open your stylesheet, select
the MadCap|indexProxy style, and set the mc-output-support property to all
(all-print is the default setting). By doing this, you can use the index proxy
method to generate an index in some online outputs as well.
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CHAPTER 4

Main Activities for Indexes
Some activities are particularly common and important when it comes to this feature.

This chapter discusses the following:

Creating Index Links 34

Enabling Indexes in Skins 50

Associating Skins With Targets 51

Creating an Index Manually for Print 52

Editing the Look of a Print Index 55
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Creating Index Links
In addition to creating regular index entries that point to a specific place in your project, you can
also create index links. An index link is an entry in a generated index that points to another entry.
There are three kinds of index links—"See," "See Also," and "Sort As."

EXAMPLE — See Link

You have written several topics about dogs, and in each of those topics you have inserted
an index marker labeled "Dogs." Therefore, when users look in the index under "Dogs," they
will be able to quickly find any of those topics. But what if users do not look under "Dogs,"
but rather "Canines"?

There are a couple of options to solve the problem. First, you could add index markers
labeled "Canines" in all of those topics. A second option is to create an index "see" link for
"Canines" that points users to "Dogs." In the output, it might look something like this:
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EXAMPLE — Sort As Link

You add "<html>" as an index keyword. Normally, without the "Sort As" feature, the keyword
would be placed at the top of the index list, before the alphabetized keywords.
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This occurs not only in the output, but also in the Index window pane in your project.
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After adding an index link set file—which is stored in the Advanced folder in the Project
Organizer—you can create a new index link for this keyword in the Index Links Editor.
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"Sort As" links apply to both first- and second-level keywords. If you were to use the term
"<html>" as both a first- and second-level keyword, the second-level keyword would also be
repositioned based on the "Sort as" link.
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How to Create Index Links Using the Index Links
Editor

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Advanced > Add Index Link Set.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Index Link Set.

The Add File dialog opens.

2. In the File Type field at the top, make sure Index Link Set is selected.

3. In the Source area, choose to create the new file based on a template or an existing file.

n New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare Desktop,
expand the Factory Templates folder and click on a template file. If you want to use
your own custom template file, expand the appropriate folder and click on a file. For
more information about templates, see the Help system.

n New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click , use the Open File dialog to find a file, and
double-click it.

4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click and select the subfolder. Otherwise,
keep the default location.

5. In the File Name field, provide a name for the index link set file.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The Index Links Editor opens. Also, the index link file (.flixl extension) is added to
the Advanced folder in the Project Organizer. In the future, you can open the index link set
from there.
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9. For each index link that you want to create for a particular term, complete the following steps
in the Index Links Editor.

a. In the local toolbar, click . The Index Link dialog opens and a new row is added to the
editor.

b. In the Term field, type the term that you anticipate users may look for in the generated
index. Please note that the fields in this dialog are case-sensitive; therefore, if you enter
a term in all lowercase letters, that is how it will be displayed in the output.

If you want to create a multi-level index entry, separate the first-level term and the
second-level term with a colon (e.g., a single-level entry might be "Pasta"; a multi-level
entry might be "Pasta:rigatoni").

If you want to insert a variable in a field, you can click . The variable will appear as
syntax in the field, but in the output the variable definition will be shown.

NOTE If you want to see the variable syntax replaced by the variable definition,
click in the local toolbar of the editor. This shows you the "Evaluated
Term," which determines the actual text of the variable.

c. Select a link type—See, See Also, or Sort As.

Use a "See" link if the term in question does not exist in the project as an index marker.
The idea is that, if a user looks for that term in the index, you want to point the person
to a different term instead of the one originally sought. You can enter one "See" link per
term.

Use a "See Also" link if the term in question does exist as an index marker somewhere
in the project. The idea is that, if a user looks for that term in the index, you want to
point the person to a different term in addition to the one originally sought. You can
create as many "See Also" links for a term as you like.

Use a "Sort As" link if you want to sort an index keyword as something else. This can be
useful when a keyword begins with a symbol (e.g., place <html> in the "h" section,
instead of at the top of the index) or if you are using character sets that should be
sorted phonetically. "Sort As" links apply to both first-level terms and second-level
terms (e.g., if you sort the first-level term "<html>" as "html," the index will also sort the
second-level term "code:<html>" as "code:html").
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d. In the Linked Term(s) field, enter the existing index entry that you want users to look
for, or the term as you want it to be sorted in the list. If you want to create a multi-level
index entry, separate the first-level term and the second-level term with a colon.

If you want to insert a variable in a field, you can click . The variable will appear as
syntax in the field, but in the output the variable definition will be shown.

e. Click OK.

10. Click to save your work.
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How to Create Index Links Using the Index
Window Pane

1. Do one of the following:

n Ribbon Select View > Index Window.

n Keyboard Shortcut Press F9 on your keyboard.

The Index window pane opens. The window pane is split into two sections—the Terms area at
the top and the Explorer area at the bottom. If you want to see more or less of either section,
you can click the splitter between them and drag it up or down.

2. Right-click in the explorer area at the bottom of the window pane, and from the context menu
select Add Index Link.

NOTE In order to see this option in the context menu, you must already have at least
one entry in the index. Also, the option is not displayed if you right-click on the root
Index heading; you must right-click below it.

3. If you do not yet have an index link set in your project, the Add Index Link Set dialog opens;
continue with the next step.

If you already have an index link set in your project, skip to step 11. The index links you create
at this point will be added to the first index link set listed in the Advanced folder of the Project
Organizer (if there is more than one index link set).

4. In the Source area, choose to create the new file based on a template or an existing file.

n New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare Desktop,
expand the Factory Templates folder and click on a template file. If you want to use
your own custom template file, expand the appropriate folder and click on a file. For
more information about templates, see the Help system.

n New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click , use the Open File dialog to find a file, and
double-click it.
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5. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click and select the subfolder. Otherwise,
keep the default location.

6. In the File Name field, provide a name for the index link set file.

7. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

8. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

9. Click Add.

10. Click OK. The Index Link dialog opens. In addition, the Index Links Editor opens. Finally, the
index link file (.flixl extension) is added to the Advanced folder in the Project Organizer. In the
future, you can open the index link set from there.

11. In the Term field, type the term that you anticipate users may look for in the generated index.
Please note that the fields in this dialog are case-sensitive; therefore, if you enter a term in all
lowercase letters, that is how it will be displayed in the output.

If you want to create a multi-level index entry, separate the first-level term and the second-
level term with a colon (e.g., a single-level entry might be "Pasta"; a multi-level entry might be
"Pasta:rigatoni").

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

NOTE If you want to include a variable, you should add the variable first, before
entering any other text. Adding a variable will clear any additional text in the field.

NOTE If you want to see the variable syntax replaced by the variable definition, click
in the local toolbar of the editor. This shows you the "Evaluated Term," which

determines the actual text of the variable.

12. Select a link type—See, See Also, or Sort As.

CHAPTER 4  45



Use a "See" link if the term in question does not exist in the project as an index marker. The
idea is that, if a user looks for that term in the index, you want to point the person to a
different term instead of the one originally sought. You can enter one "See" link per term.

Use a "See Also" link if the term in question does exist as an index marker somewhere in the
project. The idea is that, if a user looks for that term in the index, you want to point the person
to a different term in addition to the one originally sought. You can create as many "See Also"
links for a term as you like.

Use a "Sort As" link if you want to sort an index keyword as something else. This can be
useful when a keyword begins with a symbol (e.g., place <html> in the "h" section, instead of
at the top of the index) or if you are using character sets that should be sorted phonetically.
"Sort As" links apply to both first-level terms and second-level terms (e.g., if you sort the first-
level term "<html>" as "html," the index will also sort the second-level term "code:<html>" as
"code:html").

13. In the Linked Term(s) field, enter the existing index entry that you want users to look for, or
the term as you want it to be sorted in the list. If you want to create a multi-level index entry,
separate the first-level term and the second-level term with a colon.

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

14. Click OK.

15. Click to save your work.
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How to Create Index Links When Inserting
Markers

1. Open the content file.

2. Click at the location in the topic where want to insert an index keyword.

3. Do one of the following:

n Ribbon Select View > Index Window.

n Keyboard Shortcut Press F9 on your keyboard.

The Index window pane opens.

4. Click in an empty field in the Terms column.

5. Type the index link using one of the following formats, depending on whether you want to
create a "See," "See Also," or "Sort As" link:

{nopage}My Entry{see}Linked Entry

{nopage}My Entry{seealso}Linked Entry

{nopage}My Entry{sortas}Linked Entry

Use a "See" link if the term in question does not exist in the project as an index marker. The
idea is that, if a user looks for that term in the index, you want to point the person to a
different term instead of the one originally sought. You can enter one "See" link per term.

Use a "See Also" link if the term in question does exist as an index marker somewhere in the
project. The idea is that, if a user looks for that term in the index, you want to point the person
to a different term in addition to the one originally sought. You can create as many "See Also"
links for a term as you like.

Use a "Sort As" link if you want to sort an index keyword as something else. This can be
useful when a keyword begins with a symbol (e.g., place <html> in the "h" section, instead of
at the top of the index) or if you are using character sets that should be sorted phonetically.
"Sort As" links apply to both first-level terms and second-level terms (e.g., if you sort the first-
level term "<html>" as "html," the index will also sort the second-level term "code:<html>" as
"code:html").
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EXAMPLE You want to see this in the output:

In that case, you would type this in the Index window pane:

{nopage}Insects{see}Bugs

If you want to add a second level to either index keyword, type a colon after the first term, and
then type the second term.

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

NOTE If you want to include a variable, you should add the variable first, before
entering any other text. Adding a variable will clear any additional text in the field.

NOTE If you want to see the variable syntax replaced by the variable definition, click
in the local toolbar of the editor. This shows you the "Evaluated Term," which

determines the actual text of the variable.

6. Press ENTER. The index keyword link is displayed within a marker in front of the word where
you added it (as long as markers are turned on).

7. Click to save your work.
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What’s Noteworthy?

NOTE The option to create index links when inserting index markers is not supported in
Microsoft Word or Eclipse Help output.

Additionally, "Sort As" links are not supported in Microsoft Word or Eclipse Help, or
Microsoft HTML Help outputs.

NOTE If you create an index link to another term, you must make sure that you have added
that other term to the index (by manually inserting index markers or creating an auto-
index). If a linked term is not found when the index is generated, a warning is issued and the
link is skipped. Also, if a link term (the one pointing to a linked term) has been added to the
index, a warning is issued and the link is skipped.

NOTE You also may want to use span styles to change the look of the index links. For
example, you might want to make sure that the link term is displayed in bold to make it
stand out. For more information about using styles, including steps, see the Help system or
the Styles Guide.
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Enabling Indexes in Skins
Supported In:

NOTE This is supported in HTML5 Tripane output, but not in HTML5 Side Navigation, Top
Navigation, or skinless output.

After inserting index keywords, you need to enable the Index feature in the skin that you intend to
use for your target.

How to Enable an Index in a Skin
1. In the Project Organizer, open an HTML5 Tripane skin or a Standard skin.

2. On the General tab, place a check mark in the Index box.

3. Click to save your work.

CHAPTER 4  50



Associating Skins With Targets
After you add a skin to your project and edit the settings in Flare Desktop, you can associate it with
a target. After you build the target, the output will be displayed in the skin. For HTML5 targets, you
can also tell Flare Desktop not to use any skin at all.

How to Associate a Skin With a Target
1. Open the target from the Project Organizer.

2. Do one of the following, depending on the type of output:

n HTML5 Select the Skin tab.

n Others Select the General tab.

3. Click the drop-down arrow in the Skin field and select the skin that you want to associate with
the target.

If you have opened an HTML5 target and do not want to use a full skin at all, you can instead
select none. If you do this, you might want to insert various kinds of proxies and use related
skin components in order to provide navigation for your users.

4. Click to save your work.

NOTE If you are producing HTML5 output, you can also associate skin components with a
target, although it is more common to associate them with proxies.
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Creating an Index Manually for Print
Supported In:

To create an index manually for print output, you need to create a unique topic and insert an Index
proxy into it. Alternatively, you can let Flare Desktop auto-generate one for you.

The following explains how to use the manual method.
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How to Create an Index Manually for Print
1. Add a new topic as you normally would.

2. At the top of the topic, enter a title for your index.

If you apply any of Flare Desktop's h1 through h6 styles to it, the index title will be displayed in
the print TOC (if you create one).

3. Most likely, you will want to remove any text after the index title.

4. Select Insert > Proxy > Insert Index Proxy.

The Index Proxy dialog opens.

5. Complete the options in the dialog.

n Generate Headings Select whether you want the printed index to include headings (e.g.,
A, B, C).

NOTE You can also edit this setting using your stylesheet. The default setting
is to always include index headings. But if you want headings to always be
excluded from indexes, you can modify the mc-index-heading property for the
MadCap|indexProxy style.

n Column Count Select the number of columns that you want to be used in Microsoft
Word output to display the index.

NOTE This option is for Word output only. If you are producing PDF output, you
can set the number of columns for an index in the page layout.

n (Optional) Stylesheet Class You can select a style class to associate with the proxy.

You might create and use style classes if you want to generate multiple indexes with
different looks for each output. Otherwise, the index will use the style settings from the
parent MadCap|indexProxy style. You can create a style class for this purpose in the
Stylesheet Editor. To do this, select the MadCap|indexProxy style and in the local
toolbar click Add Selector to create a class. The class will then be available from this
field in the Index Proxy dialog.
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NOTE If you want to affect the look of the individual entries in the generated
index, you can use the IndexHeading and the Index1 through Index9 styles
(classes of the p style) in the Stylesheet Editor. For example, if you want to use
blue font for the first-level entries in the generated index, you can change the
font color setting on the p.Index1 style.

6. Click OK. The proxy is added to the topic.

7. Click to save your work.

NOTE By default, if your index contains entries with multiple pages in a row, this will be
displayed as a range with the pages separated by a dash. For example, instead of showing
10, 11, 12, 13, the index entry will display 10-13.

NOTE For Adobe PDF output, you can insert index-related Heading variables into page
layouts. These variables let you automatically display index headings or terms at the top of
pages.

NOTE If you are using chapter or volume autonumbers and want them to be reflected in a
print index, you can do so by specifying the autonumbers at the appropriate locations in
your outline TOC (instead of inserting Chapter or Volume Number variables in a page
layout). See "Including Page Autonumbers in Print Indexes" on page 91.
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Editing the Look of a Print Index
Supported In:

If you incorporate a generated index into your printed output, you can customize the way the index
entries look in the output. This includes adjusting properties such as font family and size, word
space, space above/below, and more. You can also change the look of the entire container holding
the generated index.

A style called "MadCap|IndexProxy" is used to control the look of the entire container. Other styles—
such as p.IndexHeading, p.Index1, p.Index2, and p.Index3—are used to control the look of individual
entries in the index. Style properties—such as margin-left, font-size, and mc-reference-initial-
separator—are used to affect the look in different ways.

Settings for the individual entries (e.g., p.IndexHeading, p.Index1) override those from
MadCap|IndexProxy.
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EXAMPLE You set a blue font on MadCap|IndexProxy. Because this style controls the
entire container, and everything within it, the index headings and all of the keywords and
page numbers are blue. The top border of the container is black, 1 px.
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However, if you set a red font on p.Index2, second-level index entries will have a red font
while everything else remains blue.
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How to Determine the Look of a Print Index
(Entire Container)

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE Some of the necessary style properties can also be changed in the Simplified
view in the Stylesheet Editor.

3. In the upper-left of the editor, make sure the drop-down field is set to
.

4. On the left side of the editor, scroll down and select the MadCap|IndexProxy style or a class
that you have created under it (e.g., MadCap|IndexProxy.myclass).

5. From the Show drop-down list on the upper-right side of the editor, select .

NOTE If you want to see properties that are of particular importance for a style, you
can select Show: Assorted Relevant Properties.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

For example, if you want to change the width of the entire index, you would first expand the
Box property group. Then to the right of width, click , and in the popup set the value.
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ABOUT COLUMN COUNT

By default, there are usually two columns used in a generated index. However, you can
change this:

n PDF For Adobe PDF output, the column count is set in a page layout.

n Word For Microsoft Word output, the default setting for the index column count is
modified in the stylesheet. With the MadCap|IndexProxy style selected, open the
Unclassified property group and change the mc-column-count property. However, you
can also override this default setting by right-clicking the actual Index proxy wherever
you have inserted it, selecting Edit Index Proxy, and editing the Column Count field.

9. Click to save your work.
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How to Determine the Look of a Print Index
(Individual Entries)

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. On the left side of the editor, expand the p style. Classes of the style are shown below it.

5. Find and select the p.Index class that you want to customize (e.g., p.Index1, p.Index2,
p.Index3).

The class p.Index1 is used for the first-level keyword in the print index, p.Index2 is used for
the second-level keyword, and so on. The p.IndexHeading class is used for customizing the
letter heading (e.g., A, B, C, D) displayed at the beginning of each section in the index.

NOTE The page numbers in the generated list inherit their style settings from the list
items before them. However, if you want the page numbers to look differently, you
can modify the MadCap|xref.IndexPageNumber style.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. From the Show drop-down list on the upper-right side of the editor, select .

NOTE If you want to see properties that are of particular importance for a style, you
can select Show: Assorted Relevant Properties.

8. Locate the property you want to change.
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NOTE Do not use the "PrintSupport" property for the Index1 through Index9 style
classes.

9. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

EXAMPLE If you want to change the font size to 10 pt, you would expand Font. Then
to the right of font-size, click , in the popup set the font size, and click OK.

10. (Optional) If you want to change the actual characters (e.g., A, B, C, D) that are used for the
headings, do the following:

a. Under the p tag on the left side of the editor, make sure IndexHeading is selected.

b. From the Show drop-down list on the upper-right side of the editor, select
.

c. If you are using the grouped view, expand the Unclassified group.

d. To the right of mc-heading-format, type the new format in the value cell. Make sure you
place the character within { and } brackets.

EXAMPLE The default format is {A}. This means the headings will simply look
like this: A, B, C, D. If you change it to {a}, the headings will be lowercase: a, b, c,
d. If you change it to -{A}-, the headings will look like this: -A-, -B-, -C-, -D-.

11. Click to save your work.
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What’s Noteworthy?

NOTE By default, if your index contains entries with multiple pages in a row, this will be
displayed as a range with the pages separated by a dash. For example, instead of showing
10, 11, 12, 13, the index entry will display 10-13.

NOTE By default index page numbers are left-aligned next to the index keywords. If instead
you want page numbers to be right-aligned on the other side of the column—you can edit
the mc-leader-offset value (found in the Unclassified property group) for the index entry
style (e.g., set it at 25 px).

NOTE For Adobe PDF output, you can insert Heading variables into page layouts. These
variables let you automatically display index headings or terms at the top of pages. For
more information see the Help system.

NOTE If you want to change the look of indexes in online output, you can do so by
modifying styles within your skin. For more information, see the Help system or the Skins
Guide.

NOTE You can change the heading text for an auto-generated index in the language skin.
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CHAPTER 5

Other Activities for Indexes
In addition to the main activities, there are some other tasks you might perform regarding this
feature.

This chapter discusses the following:

Auto-Generating Indexes for Print 65

Creating a Binary Index 79

Creating Multiline Indentation 80

Deleting Index Keywords 82

Editing Index Keywords 83

Editing Index Links 85

Excluding Index Entries From Search 89

Including Bookmarks in Index Entries 90

Including Page Autonumbers in Print Indexes 91

Including or Excluding Index Headings 96

Viewing Topics Not Indexed 97
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Auto-Generating Indexes for Print
Supported In:

To create a generated index in print output, you can let Flare Desktop auto-generate one for you, or
you can create a unique topic and insert an Index proxy into it.

The following explains how to auto-generate an index.

How to Auto-Generate an Index
1. Open a target.

2. On the Advanced tab of the Target Editor, select Generate Index Proxy.

NOTE This option is disabled by default for existing targets, but enabled for new
targets. If an Index proxy is already present in a topic or snippet that is being included
in the output, this auto-generate option has no effect.

3. Click to save your work.

When you generate the target, an index will be created and inserted after all of the other content, as
well as after an auto-generated glossary, if you include one.
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Which Page Layout is Used?
If a TOC, index, or glossary is auto-generated, how does Flare Desktop know which page layout to
use for them in the output? It uses the same page layout that is being used for the topic(s) just
before it.

EXAMPLE You have an outline TOC set up like this:

In this case, the generated TOC is going to be placed directly after the title page. It will use
the "Title" page layout which is set on the first "Title Page" entry. That page layout has a
Title page type in it. That's how Flare Desktop knows it should place the TOC directly after it
and to use the same page layout to display the TOC.

The generated glossary is going to be placed after the final entry, called "Topic 17," and the
generated index will be placed after the glossary. Both of these will use the "Chapters" page
layout, because it's the last one that was set.
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Auto-Generate vs. Manual Proxies
The auto-generate method is much quicker and easier than the manual method. The manual
method is more flexible but requires you to perform a number of extra steps, such as creating
topics, inserting proxies, and adding files to the outline TOC. So if you simply want to quickly create
print output with generated TOCs, glossaries, or indexes, the auto-generate option might be best for
you. But if you want more control over the placement and look of the generated TOCs, glossaries,
and indexes, you should use the manual method.

Editing Attributes for Generated TOCs, Indexes,
and Glossaries
You can change the heading text for each of these auto-generated proxies in the language skin.

All other attributes for the generated glossary, index, and TOC can be controlled in your stylesheet.
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EXAMPLE You need to create a PDF manual with five short chapters. You've created 17
topics that will make up those five chapters, and you've created a separate topic for a title
page.
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Your topics use <h1>, <h2>, and <h3> tags. These will become important when the TOC is
generated.
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You've inserted index keywords throughout the topics. These will become important when
the index is generated.
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You've created a glossary file and associated it with the PDF target you're going to use.
This will become important when the glossary is generated.
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You've put all of your topics into an outline TOC file. You've associated your title topic with
one page layout, and you've assigned a different page layout to the five topics that will
serve as the starting point for each of the five chapters.
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In the Target Editor, you select the Advanced tab and select Generate TOC Proxy, Generate
Index Proxy, and Generate Glossary Proxy. In addition, you also select an option labeled
Inject empty pages as needed to ensure TOC nodes start on their selected pages and
another labeled Use TOC depth for heading levels. These last two options are not required
to use the auto-generate feature, but they are popular options for generating print-based
output.
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After you generate the PDF output, it looks something like this:

CHAPTER 5  76



CHAPTER 5  77



What’s Noteworthy?

NOTE In order for an index to be generated, you must insert at least one index keyword in a
topic or snippet to be included in the output.
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Creating a Binary Index
Supported In:

You can create a binary index for your project. Binary indexes are intended for merging multiple
CHM files when you build a target. The index keywords in the CHM files are sorted alphabetically
and numerically for display in the output.

If you use this feature, please keep in mind that binary indexes do not support custom fonts.

How to Create a Binary Index
1. Create indexes in your projects.

2. Set your parent project to merge with the other CHM file(s) at run time.

3. Open a Standard skin.

4. Select the HTML Help Setup tab.

5. Click the Index Options button.

6. In the HTML Help Index Options dialog, select Binary.

7. Click OK.

8. Click to save your work.
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Creating Multiline Indentation
Supported In:

Using a style property called "mc-multiline-indent" you can specify additional indentation for
content that wraps to more than one line. Although this property can be used for any block-level
element (such as paragraphs), it is most useful when applied to print index, table of contents (TOC),
and mini-TOC entries.

How to Use a Style to Create Multiline
Indentation

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left of the editor, make sure the drop-down field is set to
.

4. Select the appropriate style. For example, you might select any of the following.

n p.Index These styles (from p.Index1 through p.Index9) control the different levels of
index entries in print-based output.

n p.TOC These styles (from p.TOC1 through p.TOC9) control the different levels of TOC
entries in print-based output.

n p.MiniTOC These styles (from p.MiniTOC1 through p.MiniTOC9) control the different
levels of mini-TOC entries in print-based output.

5. From the Show drop-down list on the upper-right side of the editor, select .

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. If you are using the group view, expand the Unclassified group.
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8. To the right of mc-multiline-indent, click .

9. Use the lower-left area of the popup to enter a number.

10. Use the lower-right area to select a unit of measurement.

11. Click OK.

12. Click to save your work.

EXAMPLE The following images show how the mc-multiline-indent style property works
alongside the margin-left property in a print index and TOC.
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Deleting Index Keywords
If necessary, you can delete index keywords that you have inserted into a topic. You can do this
from the Index window pane or from a specific topic or snippet. The advantage of using the Index
window pane is that you can delete index keywords from all topics in one step.

How to Delete a Keyword From the Index
Window Pane

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Index Window.

n Keyboard Shortcut Press F9.

2. In the explorer area at the bottom of the window pane, right-click on the index keyword or
subkeyword that you want to delete. From the context menu select Remove Keyword. The
keyword is removed from all topics where it had been inserted.

NOTE If you want to delete a keyword from the Terms area of the Index window pane, click
on the rectangular area to the left of the index keyword (on the area with the arrow ) and
press Delete on your keyboard.

How to Delete a Keyword From a Content File
1. Open the content file.

2. In the editor right-click the index marker that you want to delete.

3. From the context menu, select Delete. The index marker and its keywords are removed from
the topic.

4. Click to save your work.
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Editing Index Keywords
After you insert an index keyword, you might decide later that the index keyword needs to be
altered. You can modify an index keyword simultaneously for all topics where that keyword is
located, or you can modify it in a specific topic or snippet.

How to Edit a Keyword in Multiple Topics or
Snippets

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Index Window.

n Keyboard Shortcut Press F9.

The Index window pane opens. The window pane is split into two sections—the Terms area at
the top and the Explorer area at the bottom. If you want to see more or less of either section,
you can click the splitter between them and drag it up or down.

2. In the explorer area at the bottom of the window pane, right-click on the index keyword or
subkeyword that you want to rename. From the context menu select Rename Keyword. The
keyword is renamed in all topics where it had been inserted.

How to Edit a Keyword in a Specific Topic or
Snippet

1. Open the content file.

2. In the XML Editor, right-click on the marker holding the index keyword that you want to
modify. From the context menu, select Edit Index Keyword.

3. In the Terms column of the Index window pane, click in the cell containing the keyword that
you want to change.

4. Type the index keyword as you want it to appear in the index. If you want to add a second
level to the index keyword, type a colon after the first term, and then type the second term.
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EXAMPLE If you type Software:MadCap Flare, the term "Software" appears at
the first level of the index, and the term "MadCap Flare" appears as a subentry under
"Software."

NOTE If you want to delete a keyword from the Terms area of the Index window
pane, click on the rectangular area to the left of the index keyword (on the area with
the arrow ) and press Delete on your keyboard.

NOTE As you type in the Index window pane, notice that the cursor does not lose
focus in the XML Editor. It merely turns gray so that you know for certain where you
are adding the index keyword. When you return to the XML Editor, the cursor returns
to its previous state.

5. Press ENTER. The index keyword is modified.

6. Click to save your work.

What’s Noteworthy?

NOTE If you edit an index keyword contained in a snippet, the changes are automatically
reflected in any topics where you have inserted the snippet previously.

NOTE If you want to change how index keywords look when they're inserted in the XML
Editor, you can change the MadCap|keyword style in the Stylesheet Editor.This does not
affect the output.
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Editing Index Links
After creating index links, you may want to edit them.

One way to edit index links is to use span styles to change the look of the index links. For example,
you might want to make sure that the link term is displayed in bold to make it stand out, like this:

There are two parts that you can modify. First, you can create a style to modify the look of the "See"
or "See also" portion of the link. Second, you can create a style to modify the look of the index term
to which the link is pointing (in the example above, this would be the word "Dogs").

Another way to edit index links is to change the "See" or See also" text labels (e.g., change "See also"
to "Also see").
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How to Edit Index Links Using Span Styles
1. From the Content Explorer, open the stylesheet that you want to modify.

2. Find the span style, and expand it if you are using the Advanced view of the Stylesheet Editor.
If necessary, you can use the filter field at the top-left of the editor to select All Styles.
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3. Under the main span style, select any of the following classes:

n SeeIndex This style class lets you change the look of the word "See" in an index link.

n SeeIndexTerms This style class lets you change the look of the index entry reference in
a "See" an index link. This is a common style to use to set the index term apart from the
rest of the index link. For example, after creating this style class, you might open the
Font property group to the right and change the font-weight setting to "bold."

n SeeAlsoIndex This style class lets you change the look of the words "See Also" in an
index link.

n SeeAlsoIndexTerms This style class lets you change the look of the index entry
reference in a "See Also" an index link. This is a common style to use to set the index
term apart from the rest of the index link. For example, after creating this style class,
you might open the Font property group to the right and change the font-weight setting
to "bold."

4. Using the Stylesheet Editor, change any properties for it.

5. Click to save your work.

NOTE The span style method is not available for the web-based outputs (HTML5, Clean
XHTML, WebHelp, WebHelp Plus).
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How to Edit Index Label Text
1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Double-click a language skin to open it.

4. From the list, select a language in bold or italic font.

5. On the right side of the editor, select Print and Online.

6. If necessary, on the left side of the editor, expand the Print and Online group.

7. In the Name column, locate the Index Entry items , depending on which element you want to
change. These are the translations you will want to edit.

TIP You may want to click the column header to sort the Name column
alphabetically. Index Entry items are labeled "Index Entry."

8. Double-click in any of the Value fields and change the text as necessary.

9. Click to save your work.

NOTE If you want to change the look of index links in online output, you can do so by
modifying styles within your skin.
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Excluding Index Entries From Search
Supported In:

If you insert index markers in your project, those markers by default are included in searches that
users perform in your output. If you want to exclude index entries from searches, you can do so.

How to Exclude Index Entries From Search
1. Open the target.

2. Select the Search tab.

3. In the Search Results section, click the drop-down arrow next to Advanced Search Options.

4. Click Exclude index entries from search.

5. Click to save your work.

NOTE This option is not available for HTML5 targets using Elasticsearch or Google Search.
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Including Bookmarks in Index Entries
If you want index term links to point to the exact spot in the topic where the index marker has been
set, you need to specify this in the Skin Editor. Otherwise, the index term links will point to the topic
in general.

However, by pointing to the individual index markers, the index may not display the way you want if
the index term points to multiple topics and you also have created a binary index . In other words,
index entries pointing to multiple topics will display the index terms repeated instead of the topic
title. A workaround is to deselect the binary index option in the Skin Editor. However, keep in mind
that a binary index is required if you want to merge CHM files.

How to Include Bookmarks in Index Entries
1. Open a Standard skin.

2. Select the HTML Help Setup tab.

3. Click the Index Options button.

4. In the HTML Help Index Options dialog, select Include bookmarks with index entries.

5. Click OK.

6. Click to save your work.
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Including Page Autonumbers in Print
Indexes

There are two basic methods for adding page autonumbers (i.e., page numbers that also include
the chapter or volume autonumber) to print-based output—(1) by inserting variables into page
layout frames or (2) by setting the autonumbers on the outline TOC entries where new "chapters"
start. With the first method, the autonumbers are shown on your main content pages, but they are
not included in a generated print index. With the second method, the autonumbers are shown both
on your main content pages and in a generated index. You would use the first method if you want a
quicker process and are not including a print index, but you would use the second method if you
need the autonumbers to show up in an index.

CHAPTER 5  91



Methods
n Insert Variables into Page Layout Frames (Not Supported in Print Index) With this method,

you can insert the appropriate autonumber variables in your page layouts. This is the fastest
and easiest solution if you are not also creating a print index. For more information see the
Help system.

EXAMPLE You have a project with chapter autonumbers in topics that you have
designed to be the start of new chapters in your output. In order to include those
same chapter numbers in the page numbering, you opened your page layout,
selected the footer frame, and pressed F2 to edit it.

Inside that footer frame, you inserted a chapter number variable, typed a period, and
then inserted a page number placeholder. Like this:

When you view the generated output, you see the page numbers displayed correctly
as 1.1, 1.2, 1.3, 2.1, 2.2, and so on. Unfortunately, if you also include a print index in
the output, the page numbers are displayed as 1, 2, 3, 4, etc. In other words, the page
numbers are shown in the index, but the chapter autonumbers are not.

n Set Autonumbers on Outline TOC Entries (Supported in Print Index) If you intend to include a
print index in the output, you should not insert the autonumber variable in the page layout.
Instead, you should set the chapter or volume autonumbers in the TOC Editor, at the same
locations where you create chapter breaks for the output. The following steps show you how
to do this.
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How to Set Autonumbers on Outline TOC Entries
and Include in an Index

1. Set up your topics to use chapter or volume autonumbers where appropriate (e.g., on the
heading for a topic that will come first in a new chapter). For more information see the Help
system.

2. Create your page layout(s). In the appropriate header or footer frames, insert a page number
placeholder. Do not insert a chapter or volume number variable. For more information see the
Help system.

EXAMPLE You have a project with chapter autonumbers in topics that you have
designed to be the start of new chapters in your output. You want to include those
same chapter numbers in the page numbering at the bottom of pages, and you also
want them to display in a print index that you are creating.

First, open your page layout, select the footer frame, and press F2 to edit it. Inside
that footer frame, you insert a page number placeholder. When finished, it should
look something like this:

3. Open your outline TOC and double-click an entry where you want to start a new chapter or
volume. The Properties dialog opens.

4. Select the Printed Output tab.

5. In the Break Type field select Chapter Break and complete the other fields in that area as
necessary. For more information see the Help system.

6. In the Page Number area, click in the Format field and select text.
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7. In the Reset to field, enter the appropriate commands. For a chapter autonumber, you can
use {chapnum}. For a volume autonumber, you can use {volnum}. You can also insert any
text, such as a period or dash, as well as a counter command, such as {n}.

EXAMPLE You want to display the chapter autonumber, followed by a period and
then the page number. In that case, you would type the following:

{chapnum}.{n}

The {chapnum} command indicates a chapter autonumber. If you had wanted to
show the volume autonumber instead, you would have used the {volnum} command.

Because you want a period to separate the chapter autonumber and the incremented
page number, you simply type it. Then you add the page number command, which is
{n}.

8. Select the Autonumbers tab.

9. For the first chapter or volume in your output, you will most likely want to select the
appropriate Reset to option and enter 1. For subsequent chapters or volumes, you will
probably want to select Increment number.

10. Click OK.
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11. Repeat steps 3-10 for each TOC entry that is designed to start a new chapter or volume. By
holding down the CTRL or SHIFT key, you can select multiple entries in the outline TOC and
provide the settings for all of them at one time.

12. Click to save your work.

13. Create a topic to hold your print index and add it to your outline TOC .

14. Build and view the output.

When you view the generated output, you will see the page numbers displayed correctly (e.g.,
1.1, 1.2, 1.3, 2.1, 2.2, and so on). In the generated print index, you will see the same
autonumber/page number combination—as long as your topics include index keywords (see
"Inserting Index Keywords" on page 16).

What’s Noteworthy?

NOTE Only chapter and volume autonumbers are supported. Section autonumbers are not
supported in this feature.
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Including or Excluding Index Headings
Supported In:

When you insert an Index proxy for print-based output, you can specify whether the generated index
should include headings above the alphabetical groups of entries. The default setting is "True,"
meaning that index headings will be included. However, you can always override this setting at the
spot where a particular Index proxy is inserted. If you want all index proxies to not include headings
by default, you can edit the mc-index-headings property, setting it to "False."

How to Include or Exclude Index Headings
1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. In the Styles section on the left side of the editor, find and select the style called
MadCap|indexProxy (or a style class you have created within that style).

5. From the Show drop-down list on the upper-right side of the editor, select .

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. If you are using the group view, expand the Unclassified property group.

8. To the right of mc-index-headings, click and select true (to include headings) or false (to
exclude them).

9. Click to save your work.
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Viewing Topics Not Indexed
You can view a list of all topics where you have not yet inserted index keywords. Therefore, no
references to those topics will be found in the generated index. You can also double-click a row to
open the topic in question. 

How to View Topics Not Indexed
1. Select Analysis > More Reports > Topics Not In Index.

The Topics Not In Index window pane opens. The area at the bottom of the window pane
displays all topics where you have not yet inserted index keywords.

2. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n File Displays the name of the file.

n Title Displays the properties title of the file (if any).

n Folder Displays the folder where the file is found.

3. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

NOTE You can open any file in the list to view or modify it in an editor. You can either
double-click on the specific row, or right-click on the row and select Open.
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APPENDIX

PDFs
The following PDFs are available for download from the Help system.

Tutorials
Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Getting Started Tutorial

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

MadCap Flare Online
Integration Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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